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 Important Information

Warranty
The SCXI-1503 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
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Conventions

The following conventions are used in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a 
range of values associated with a bit or signal name—for example, 
P0.<3..0>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
the product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product it denotes a warning advising you to 
take precautions to avoid electrical shock.

When symbol is marked on a product it denotes a component that may be 
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, hardware labels, 
or an introduction to a key concept. Italic text also denotes text that is a 
placeholder for a word or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.
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1
About the SCXI-1503

This manual describes the electrical and mechanical aspects of the 
SCXI-1503 module and contains information concerning its installation 
and operation. The SCXI-1503 module provides 16 differential input 
channels and 16 channels of 100 μA current excitation and one cold 
junction sensor channel. The SCXI-1503 is ideally suited for measuring 
resistive transducers, such as RTDs or thermistors.

Each channel has an amplifier with a selectable gain of 1 or 100 and a 
lowpass filter with a 5 Hz cutoff frequency to reject 50/60 Hz noise.

The SCXI-1503 can programmatically connect each input to ground, which 
greatly improves its accuracy by enabling a self-calibration of each input to 
reduce offset drift errors.

You can multiplex several SCXI-1503 modules and other SCXI modules 
into a single channel on the DAQ device, greatly increasing the number of 
analog input signals that you can digitize.

Detailed specifications of the SCXI-1503 modules are listed in 
Appendix A, Specifications.

What You Need to Get Started
To set up and use the SCXI-1503, you need the following items:

❑ Hardware

– SCXI-1503 module

– One of the following terminal blocks:

• SCXI-1306—front-mount terminal block with screw 
terminal connectivity.

• SCXI-1310—custom kit for custom connectivity.

• TBX-96—DIN EN mount terminal block with screw terminal 
connectivity.

– SCXI or PXI/SCXI combo chassis
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– One of the following:

• SCXI-1600

• E/M Series DAQ device

– Computer

– Cabling, cable adapter, and sensors as required for your 
application

❑ Software

– NI-DAQ 8.1 or later

– Application software, such as LabVIEW, LabWindows™/CVI™, 
Measurement Studio, or other programming environments

❑ Documentation

– Read Me First: Safety and Radio-Frequency Interference

– DAQ Getting Started Guide

– SCXI Quick Start Guide

– SCXI-1503 User Manual

– Terminal block installation guide

– Documentation for your software

❑ Tools

– Wire cutter

– Wire stripper

– Flathead screwdriver

– Phillips screwdriver

National Instruments Documentation
The SCXI-1503 User Manual is one piece of the documentation set for data 
acquisition (DAQ) systems. You could have any of several types of 
manuals depending on the hardware and software in the system. Use the 
manuals you have as follows:

• The SCXI Quick Start Guide—This document contains a quick 
overview for setting up an SCXI chassis, installing SCXI modules and 
terminal blocks, and attaching sensors. It also describes setting up the 
SCXI system in MAX.
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• SCXI or PXI/SCXI chassis manual—Read this manual for 
maintenance information on the chassis and for installation 
instructions.

• The DAQ Getting Started Guide—This document has information on 
installing NI-DAQ and the E/M Series DAQ device. Install these 
before you install the SCXI module.

• The SCXI hardware user manuals—Read these manuals for detailed 
information about signal connections and module configuration. They 
also explain, in greater detail, how the module works and contain 
application hints.

• Accessory installation guides or manuals—Read the terminal block 
and cable assembly installation guides. They explain how to physically 
connect the relevant pieces of the system. Consult these guides when 
you are making the connections.

• The E/M Series DAQ device documentation—This documentation has 
detailed information about the DAQ device that plugs into or is 
connected to the computer. Use this documentation for hardware 
installation and configuration instructions, specification information 
about the DAQ device, and application hints.

• Software documentation—You may have both application software 
and NI-DAQ software documentation. National Instruments (NI) 
application software includes LabVIEW, LabWindows/CVI, and 
Measurement Studio. After you set up the hardware system, use either 
your application software documentation or the NI-DAQ 
documentation to help you write your application. If you have a large, 
complex system, it is worthwhile to look through the software 
documentation before you configure the hardware.

• One or more of the following help files for software information:

– Start»Programs»National Instruments»NI-DAQ» 
NI-DAQmx Help

– Start»Programs»National Instruments»NI-DAQ» 
Traditional NI-DAQ User Manual

– Start»Programs»National Instruments»NI-DAQ» 
Traditional NI-DAQ Function Reference Help

You can download NI documents from ni.com/manuals. To download 
the latest version of NI-DAQ, click Drivers and Updates at ni.com.
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Installing Application Software, NI-DAQ, and the 
E/M Series DAQ Device

Refer to the DAQ Getting Started Guide packaged with the NI-DAQ 
software to install your application software, NI-DAQ driver software, and 
the DAQ device to which you will connect the SCXI-1503. NI-DAQ 8.1 or 
later is required to configure and program the SCXI-1503 module. If you 
do not have NI-DAQ 8.1 or later, you can either contact an NI sales 
representative to request it on a CD or download the latest NI-DAQ version 
from ni.com.

Note Refer to the Read Me First: Radio-Frequency Interference document before 
removing equipment covers or connecting or disconnecting any signal wires.

Installing the SCXI-1503 Module into the SCXI Chassis
Refer to the SCXI Quick Start Guide to install your SCXI-1503 module.

Installing the Terminal Block
Table 1-1 shows the supported SCXI-1503 terminal blocks. Refer to the 
SCXI Quick Start Guide and the terminal block installation guide for more 
information about the terminal block.

Configuring the SCXI System Software
Refer to the SCXI Quick Start Guide and the user manuals of the modules 
in your application to configure and verify them in software.

Table 1-1.  Supported SCXI-1503 Terminal Blocks

Terminal Block CJC Sensor Measurement Type

SCXI-1306 Yes Resistive temperature 
measurements

TBX-96 No Custom signals

SCXI-1310 No

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 1 About the SCXI-1503

© National Instruments Corporation 1-5 SCXI-1503 User Manual

Verifying the SCXI-1503 Installation
Refer to the SCXI Quick Start Guide, for details about testing the SCXI 
chassis and module installation in software. Refer to Chapter 3, 
Configuring and Testing, for details about setting up a task and verifying 
the input signal.
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2
Connecting Signals

This chapter describes the input and output signal connections to the 
SCXI-1503 module with the module front connector and rear signal 
connector. This chapter also includes connection instructions for the 
signals on the SCXI-1503 module when using the SCXI-1306 terminal 
block.

In addition to this section, refer to the installation guide of the terminal 
block for detailed information regarding connecting the signals. If you are 
using a custom cable or connector block, refer to the Front Connector 
section.

Analog Input Signal Connections
Each differential input (AI+ and AI–) goes to a separate filter and amplifier 
that is multiplexed to the module output buffer. If the terminal block has a 
temperature sensor, the sensor output—connected to pins A3 and/or A4 
(CJ SENSOR)—is also filtered and multiplexed to the module output 
buffer.

The differential input signal range of an SCXI-1503 module input channel 
is ±10 V when using a gain of 1 or ±0.1 V when using a gain of 100. This 
differential input range is the maximum measurable voltage difference 
between the positive and negative channel inputs. The common-mode input 
signal range of an SCXI-1503 module input channel is ±10 V. This 
common-mode input range for either positive or negative channel input is 
the maximum input voltage that results in a valid measurement. Each 
channel includes input protection circuitry to withstand the accidental 
application of voltages up to ±42 VDC powered on or ±25 VDC 
powered off.

Caution Exceeding the input damage level (±42 VDC powered on or ±25 VDC powered 
off between input channels and chassis ground) can damage the SCXI-1503 module, the 
SCXIbus, and the DAQ device. NI is not liable for any injuries resulting from such signal 
connections.
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Note Exceeding the differential or common-mode input channel ranges results in a 
distorted signal measurement, and can also increase the settling time requirement of the 
connected E/M Series DAQ device.

Ground-Referencing the Signals
Do not ground signals that are already ground-referenced; doing so results 
in a ground loop, which can adversely affect the measurement accuracy. 
Directly grounding floating signals to the chassis ground without using a 
bias resistor is not recommended as this can result in noisy readings

Connecting Resistive Devices to the SCXI-1503
You can connect resistive devices to the SCXI signal conditioning system 
in a 4-, 2-, or 3-wire configuration. Figures 2-1 through 2-4 illustrate 
various ways to connect sensors for current excitation and voltage 
measurements using the SCXI-1503 with the SCXI-1306 terminal block.

Refer to the appropriate ADE and SCXI documentation for information 
concerning setting appropriate voltage gains for the analog inputs.

You can use the SCXI-1306 terminal block to make signal connections to 
the SCXI-1503. When using the SCXI-1306 terminal block, refer to the 
SCXI-1306 Terminal Block Installation Guide.
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4-Wire Configuration
The 4-wire configuration, also referred to as a Kelvin connection, is shown 
in Figure 2-1. The 4-wire configuration uses one pair of wires to deliver the 
excitation current to the resistive sensor and uses a separate pair of wires to 
sense the voltage across the resistive sensor. Because of the high input 
impedance of the differential amplifier, negligible current flows through 
the sense wires. This results in a very small lead-resistance voltage drop 
error. The main disadvantage of the 4-wire connection is the greater 
number of field wires required.

Figure 2-1.  4-Wire Resistive Sensor Connected in a 4-Wire Configuration

External Sensor SCXI-1306

+
–

SCXI-1503

Channel X
IEX+

AI+

AI–

IEX–

I = 100 µA

ON

CH X

RL3

RL2

RL1

RL4
RT
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2-Wire Configuration
The basic 2-wire configuration is shown in Figure 2-2. In this configuration 
an error voltage (VE) is introduced into the measurement equal to the 
excitation current (IEX) times the sum of the two lead resistances, RL1 and 
RL2. If we assume equal lead resistances, RL1 = RL2 = RL, the magnitude of 
the error voltage is:

This is the most commonly used configuration for connecting thermistors 
to a signal conditioning system because the large sensitivity of thermistors 
usually results in the introduction of a negligible error by the lead 
resistances.

RTDs typically have a much smaller sensitivity and nominal resistance than 
thermistors, therefore a 2-wire configuration usually results in the 
introduction of larger errors by the lead resistance.

Figure 2-2.  2-Wire Resistive Sensor Connected in a 2-Wire Configuration

VE 2RLIEX=

ON

CH X

+
–

SCXI-1306External Sensor SCXI-1503

Channel X
IEX+

AI+

AI–

IEX–

I = 100 µA

RL1

RL2
RT
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3-Wire Resistive Sensor Configuration
If you are using a 3-wire resistive sensor, you can reduce the error voltage 
by one-half over the 2-wire measurement by connecting the device as 
shown in Figure 2-3. In this configuration, very little current flows through 
RL3 and therefore RL2 is the only lead resistance that introduces an error into 
the measurement. The resulting measurement error is:

Figure 2-3.  3-Wire Resistive Sensor Configuration

VE RL2IEX=

+
–

SCXI-1503

Channel X
IEX+

AI+

AI–

IEX–

SCXI-1306External Sensor

ON

CH X

I = 100 µA

RL2

RL1

RL3

RT
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Lead-Resistance Compensation Using a 3-Wire Resistive Sensor and 
Two Matched Current Sources

You can compensate for the errors introduced by lead-resistance voltage 
drops by using a 3-wire resistive sensor and two matched current sources 
connected as shown in Figure 2-4.

Figure 2-4.  3-Wire Configuration Using Matched Current Sources

+
–

SCXI-1503

EX0+

AI0+

AI0–

EX0–

SCXI-1306External Sensor

ON

I = 100 µA

+
–

EX1+

AI1+

AI1–

EX1–

I = 100 µA

ON

RL3

RL1

RL2

RT
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In this configuration, the lead-resistance voltage drop across RL3 is 
converted into a common-mode voltage that is rejected by the differential 
amplifier. Also, the polarity of the lead-resistance voltage drops across RL1 
and RL2 are series opposing, relative to the inputs of the differential 
amplifier, eliminating their effect on the voltage measured across RT.

Note RL1 and RL2 are assumed to be equal.

The effectiveness of this method depends on the matching of the current 
sources. Each current source on the SCXI-1503 has an accuracy of ±0.05%. 
This accuracy results in a worst-case matching of ±0.1%. Refer to the 
Chapter 4, Theory of Operation, for accuracy considerations of RTDs and 
thermistors.

Front Connector
The pin assignments for the SCXI-1503 front signal connector are shown 
in Table 2-1.

Note Do not make any connections to RSVD pins.
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Table 2-1.  Front Signal Pin Assignments

Front Connector Diagram Pin Number Column A Column B Column C

32 GND AI0– AI0+

31 GND AI1– AI1+

30 GND AI2– AI2+

29 GND AI3– AI3+

28 RSVD AI4– AI4+

27 RSVD AI5– AI5+

26 RSVD AI6– AI6+

25 RSVD AI7– AI7+

24 NC IEX0– IEX0+

23 NC IEX1– IEX1+

22 NC IEX2– IEX2+

21 NC IEX3– IEX3+

20 RSVD IEX4– IEX4+

19 RSVD IEX5 IEX5+

18 NC IEX6– IEX6+

17 NC IEX7– IEX7+

16 GND AI8– AI8+

15 GND AI9– AI9+

14 GND AI10– AI10+

13 GND AI11– AI11+

12 NC AI12– AI12+

11 NC AI13– AI13+

10 NC AI14– AI14+

9 NC AI15– AI15+

8 NC IEX8– IEX8+

7 NC IEX9– IEX9+

6 NC IEX10– IEX10+

5 NC IEX11– IEX11+

4 CJ SENSOR IEX12– IEX12+

3 CJ SENSOR IEX13– IEX13+

NC—no connection

RSVD—reserved

2 CGND IEX14– IEX14+

1 +5 V IEX15– IEX15+

Column
A      B      C

32

31

30

29

28

27

26

25

24

23

22

21

20

19

18

17

16

15

14

13

12

11

10

9

8

7

6

5

4

3

2

1
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Table 2-2.  Signal Descriptions

Pin Signal Name Description

A1 +5 V +5 VDC Source—Used to power circuitry on the 
terminal block. 0.1 mA of source not protected.

A13 – A16,
A29 – A32

GND Ground—Tied to the SCXI module ground.

A1, A19, A20,
A25 – A28

RSVD Reserved—This pin is reserved. Do not connect 
any signal to this pin.

A2 C GND Chassis Ground—Connects to the SCXI chassis.

B24 – B17,
B8 – B1

IEX<0..7> –,
IEX<8..15> –

Negative Excitation—Connects to the channel 
ground reference. This is the return path for the 
corresponding IEX+ channel.

C24 – C17,
C8 – C1

IEX<0..7> +,
IEX<8..15> +

Positive Excitation—Connects to the positive 
current output of the channel.

A3, A4 CJ SENSOR Cold-Junction Temperature Sensor 
Input—Connects to the temperature sensor of 
the terminal block.

B30 – B 25,
B16 – B9

AI <0..7> –,
AI <8..15> –

Negative Input Channels—Negative side of 
differential input channels.

C32 – C25,
C16 – C9

AI <0..7> +,
AI <8..15> +

Positive Input Channels—Positive side of 
differential input channels.
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Rear Signal Connector
Table 2-3 shows the SCXI-1503 module rear signal connector pin 
assignments.

Table 2-3.  Rear Signal Pin Assignments

Rear Connector Diagram Signal Name Pin Number Pin Number  Signal Name

AI GND 1 2 AI GND

AI 0 + 3 4 AI 0 –

NC 5 6 NC

NC 7 8 NC

NC 9 10 NC

NC 11 12 NC

NC 13 14 NC

NC 15 16 NC

NC 17 18 NC

NC 19 20 NC

NC 21 22 NC

NC 23 24 DIG GND

SER DAT IN 25 26 SER DAT OUT

DAQ D*/A 27 28 NC

SLOT 0 SEL* 29 30 NC

NC 31 32 NC

DIG GND 33 34 NC

NC 35 36 SCAN CLK

SER CLK 37 38 NC

NC 39 40 NC

NC 41 42 NC

RSVD 43 44 NC

NC 45 46 RSVD

NC means no connection.

RSVD means reserved.

NC 47 48 NC

NC 49 50 NC

49 50

47 48

45 46

43 44

41 42

39 40

37 38

35 36

33 34

31 32

29 30

27 28

25 26

23 24

21 22

19 20

17 18

15 16

13 14

11 12

9 10

7 8

5 6

3 4

1 2
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Rear Signal Connector Descriptions
The rear signal connector on the cabled module is the interface between 
the DAQ device and all modules in the SCXI chassis. AI 0 is used to 
differentially multiplex all 16 channels, the CJ sensor, and analog signals 
from the modules to the connected DAQ device.

The communication signals between the DAQ device and the SCXI system 
are listed in Table 2-4. If the DAQ device is connected to the SCXI-1503, 
these digital lines are unavailable for general-purpose digital I/O.

Table 2-4.  SCXI-1503 50-Pin Rear Connector Signals

Pin
SCXI 

Signal Name

 NI-DAQmx 
Device Signal 

Name Direction Description

1, 2 AI GND AI GND — Analog input ground—connects to 
the analog input ground of the DAQ 
device.

3 AI 0 + AI 0 + Input Channel 0 positive—used to 
differentially multiplex all 
16 channels, the CJ sensor, and 
analog signals from the modules to 
the connected DAQ device.

4 AI 0 – AI 0 – Input Channel 0 negative—used to 
differentially multiplex all 
16 channels, the CJ sensor, and 
analog signals from the modules to 
the connected DAQ device.

24, 33 DIG GND D GND — Digital ground—these pins supply 
the reference for E/M Series DAQ 
device digital signals and are 
connected to the module digital 
ground.

25 SER DAT IN P0.0 Input Serial data in—this signal taps into 
the SCXIbus MOSI line to send 
serial input data to a module or 
Slot 0.
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26 SER DAT OU
T

P0.4 Output Serial data out—this signal taps 
into the SCXIbus MISO line to 
accept serial output data from a 
module.

27 DAQ D*/A P0.1 Input Board data/address line—this 
signal taps into the SCXIbus D*/A 
line to indicate to the module 
whether the incoming serial stream 
is data or address information.

29 SLOT 0 SEL* P0.2 Input Slot 0 select—this signal taps into 
the SCXIbus INTR* line to indicate 
whether the information on MOSI 
is being sent to a module or Slot 0.

36 SCAN CLK AI HOLD COMP, 
AI HOLD

Input Scan clock—a rising edge indicates 
to the scanned SCXI module that 
the E/M Series DAQ device has 
taken a sample and causes the 
module to advance channels.

37 SER CLK EXTSTROBE* Input Serial clock—this signal taps into 
the SCXIbus SPICLK line to clock 
the data on the MOSI and MISO 
lines.

43, 46 RSVD RSVD Input Reserved.

Note: All other pins are not connected.

Table 2-4.  SCXI-1503 50-Pin Rear Connector Signals (Continued)

Pin
SCXI 

Signal Name

 NI-DAQmx 
Device Signal 

Name Direction Description
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3
Configuring and Testing

This chapter discusses configuring the SCXI-1503 in MAX using 
NI-DAQmx, creating and testing a virtual channel, global channel, 
and/or task.

Notes You must have NI-DAQmx 8.1 or later installed.

Refer to the SCXI Quick Start Guide if you have not already configured the chassis.

SCXI-1503 Software-Configurable Settings
This section describes how to set the gain/input signal range and how to 
configure your software for compatible sensor types. It also describes how 
to perform configuration of these settings for the SCXI-1503 in 
NI-DAQmx. For more information on the relationship between the settings 
and the measurements and how to configure settings in your application, 
refer to Chapter 4, Theory of Operation.

Common Software-Configurable Settings
This section describes the most frequently used software-configurable 
settings for the SCXI-1503. Refer to Chapter 5, Using the SCXI-1503, 
for a complete list of software-configurable settings.

Gain/Input Range
Gain/input range is a software-configurable setting that allows you to 
choose the appropriate amplification to fully utilize the range of the 
E/M Series DAQ device. In most applications NI-DAQ chooses and sets 
the gain for you determined by the input range. This feature is described in 
Chapter 5, Using the SCXI-1503. Otherwise, you should determine the 
appropriate gain using the input signal voltage range and the full-scale 
limits of the SCXI-1503 output. You can select a gain of 1 or 100 on a per 
channel basis.
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Input Coupling
The front end of the SCXI-1503 includes a software configurable switch 
that allows you to programmatically connect the input channels of the 
SCXI-1503 to either the front connector or internal ground. When using 
autozero, the coupling mode is set automatically. Refer to Table 5-1, 
NI-DAQmx Voltage Measurement Properties, for details about the 
available input coupling modes supported by the SCXI-1503.

CJC Source/Value
When using a terminal block that has a CJ sensor for thermocouple 
measurements, you can set the CJC source as internal, which scans the 
sensor at the beginning of each measurement and scales the readings 
accordingly.

Auto-Zero
Setting the Auto-zero mode to Once improves the accuracy of the 
measurement. With auto-zero enabled, the inputs of the SCXI-1503 are 
internally grounded. The driver makes a measurement when the task begins 
and then subtracts the measured offset from all future measurements.

Configurable Settings in MAX

Note If you are not using an NI ADE or are using an unlicensed copy of an NI ADE, 
additional dialog boxes from the NI License Manager appear allowing you to create a task 
or global channel in unlicensed mode. These messages continue to appear until you install 
version 8.1 or later of an NI ADE.

This section describes where you can access each software-configurable 
setting in MAX. The location of the settings varies depending on the 
version of NI-DAQmx you use. Refer to the DAQ Getting Started Guide 
and the SCXI Quick Start Guide for more information on installing and 
configuring the hardware. You can use DAQ Assistant to graphically 
configure common measurement tasks, channels, or scales.
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NI-DAQmx
Using NI-DAQmx, you can configure software settings such as sensor type 
and gain/input signal range in the following ways:

• Task or global channel in MAX

• Functions in your application

Note All software-configurable settings are not configurable both ways. This section only 
discusses settings in MAX. Refer to Chapter 5, Using the SCXI-1503, for information on 
using functions in your application.

Dependent upon the terminal block configuration use, you can use the 
SCXI-1503 module to make the following types of measurements:

• Voltage input

• Thermocouple

• RTD

• Thermistors

Creating a Global Channel or Task
To create a new voltage, temperature, or current input NI-DAQmx global 
task or channel, complete the following steps:

1. Double-click Measurement & Automation on the desktop.

2. Right-click Data Neighborhood and select Create New.

3. Select NI-DAQmx Task or NI-DAQmx Global Channel, and click 
Next.

4. Select Analog Input.

5. Select one of the following:

• Voltage

• Temperature and then select one of the following:

– Iex Thermistor

– RTD

– Thermocouple

– Vex Thermistor

6. If you are creating a task, you can select a range of channels by holding 
down the <Shift> key while selecting the channels. You can select 
multiple individual channels by holding down the <Ctrl> key while 
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selecting channels. If you are creating a channel, you can only select 
one channel. Click Next.

7. Name the task or channel and click Finish.

8. Select the channel(s) you want to configure. You can select a range of 
channels by holding down the <Shift> key while selecting the 
channels. You can select multiple individual channels by holding down 
the <Ctrl> key while selecting channels.

Note  If you want to add channels of various measurement types to the same task, click 
the Add Channels button to select the measurement type for the additional channels.

9. Enter the specific values for your application in the Settings tab. 
Context help information for each setting is provided on the right 
side of the screen. Configure the input signal range using either 
NI-DAQmx Task or NI-DAQmx Global Channel. When you set the 
minimum and maximum range of NI-DAQmx Task or NI-DAQmx 
Global Channel, the driver selects the best gain for the measurement. 
You also can set it through your application.

10. If you are creating a task and want to set timing or triggering controls, 
enter the values in the Task Timing and Task Triggering tabs.

11. Click Device and select Auto Zero mode if desired.

Verifying the Signal
This section describes how to take measurements using test panels in order 
to verify signal, and configuring and installing a system in NI-DAQmx.

Verifying the Signal in NI-DAQmx Using a Task or Global Channel
You can verify the signals on the SCXI-1503 using NI-DAQmx by 
completing the following steps:

1. Expand Data Neighborhood.

2. Expand NI-DAQmx Tasks.

3. Click the task you created in the Creating a Global Channel or Task 
section.

4. Select the channel(s) you want to verify. You can select a block of 
channels by holding down the <Shift> key or multiple channels by 
holding down the <Ctrl> key. Click OK.

5. Enter the appropriate information on the Settings and Device tab.
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6. Click the Test button.

7. Click the Start button.

8. After you have completed verifying the channels, click the Stop 
button.

You have now verified the SCXI-1503 configuration and signal connection.

Note For more information on how to further configure the SCXI-1503, or how to use 
LabVIEW to configure the module and take measurements, refer to Chapter 5, Using the 
SCXI-1503.
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4
Theory of Operation

This chapter provides a brief overview and a detailed discussion of the 
circuit features of the SCXI-1503 module. Refer to Figure 4-1 while 
reading this section.
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Figure 4-1.  Block Diagram of SCXI-1503
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The major components of the SCXI-1503 modules are as follows:

• Rear signal connector

• SCXIbus connector

• SCXIbus interface

• Digital control circuitry

• Analog circuitry

The SCXI-1503 modules consist of 16 multiplexed input channels, each 
with a software-programmable gain of 1 or 100. Each input channel has its 
own lowpass filter. Each channel has a fixed 100 μA current excitation. The 
SCXI-1503 modules also have a digital section for automatic control of 
channel scanning, temperature sensor selection, gain selection, and 
auto-zero mode.

Rear Signal Connector, SCXIbus Connector, and 
SCXIbus Interface

The SCXIbus controls the SCXI-1503 module. The SCXIbus interface 
connects the rear signal connector to the SCXIbus, allowing a DAQ device 
to control the SCXI-1503 module and the rest of the chassis.

Digital Control Circuitry
The digital control circuitry consists of the Address Handler and registers 
that are necessary for identifying the module, reading/setting calibration 
information, setting the gain, and selecting the appropriate channel.

Analog Circuitry
The analog circuitry per channel consists of a fixed lowpass filter and an 
amplifier with a software selectable gain of 1 or 100. The CJ SENSOR 
channel has a lowpass filter buffered by a unity gain amplifier. The 
channels and CJ SENSOR are multiplexed to a single output buffer.

Analog Input Channels
Each of the 16 differential analog input channels feeds to a separate 
instrumentation amplifier with a programmable gain of 1 or 100. Each 
channel has a fixed 100 μA current excitation. Then the signal passes 
through a fixed 2-pole, 5 Hz lowpass filter.
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The CJ SENSOR input channel is used to read the sensor temperature from 
the terminal block. The temperature sensor is for cold-junction 
compensation of thermocouple measurements. The CJ SENSOR channel 
also passes through a 5 Hz lowpass filter to reject unwanted noise on the 
SCXI-1503. Along with the other 16 input channels, the CJ SENSOR is 
multiplexed to the output buffer, where it can be read by the DAQ device.

Operation of the Current Sources
The current sources on the SCXI-1503 continuously provide 16 channels 
of 100 μA current excitation. These current sources are on whenever the 
SCXI chassis is powered-on. The current sources on the SCXI-1503 are 
designed to be accurate to within ±0.05% of the specified value with a 
temperature drift of no more than ±5 ppm/°C. The high accuracy and 
stability of these current sources makes them especially well suited to 
measuring resistance to a high degree of accuracy.

Theory of Multiplexed Operation
In multiplexed mode, all input channels of an SCXI module are 
multiplexed into a single analog input channel of the DAQ device. 
Multiplexed mode operation is ideal for high channel count systems. 
Multiplexed mode is typically used for performing scanning operations 
with the SCXI-1503. The power of SCXI multiplexed mode scanning is its 
ability to route many input channels to a single channel of the DAQ device.

The multiplexing operation of the analog input signals is performed 
entirely by multiplexers in the SCXI modules, not inside the DAQ device 
or SCXI chassis. In multiplexed mode the SCXI-1503 scanned channels are 
kept by the NI-DAQ driver in a scan list. Immediately prior to a multiplexed 
scanning operation, the SCXI chassis is programmed with a module scan 
list that controls which module sends its output to the SCXIbus during a 
scan through the cabled SCXI module.

The list can contain channels in any physical order and the multiplexer can 
sequence the channel selection from the scan list in any order. The ordering 
of scanned channels need not be sequential. Channels can occur multiple 
times in a single scan list. The scan list can contain an arbitrary number of 
channels for each module entry in the scan list, limited to a total of 
512 channels per DAQ device. This is referred to as flexible scanning 
(random scanning). Not all SCXI modules provide flexible scanning.
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The module includes first-in first-out (FIFO) memory for storing the 
channel scan list defined in your application code. NI-DAQ drivers load the 
FIFO based on the channel assignments you make in your application. You 
need not explicitly program the module FIFO as this is done automatically 
for you by the NI-DAQ driver.

When you configure a module for multiplexed mode operation, the routing 
of multiplexed signals to the DAQ device depends on which module in the 
SCXI system is cabled to the DAQ device. There are several possible 
scenarios for routing signals from the multiplexed modules to the DAQ 
device.

If the scanned SCXI-1503 module is not directly cabled to the DAQ device, 
the module sends its signals through the SCXIbus to the cabled module. 
The cabled module, whose routing is controlled by the SCXI chassis, routes 
the SCXIbus signals to the DAQ device through the AI 0 pin on its rear 
signal connector.

If the DAQ device scans the cabled module, the module routes its input 
signals through the AI 0 pin on its rear signal connector to a single channel 
on the DAQ device.

Measuring Temperature with Resistive Transducers
This section discusses RTDs and thermistors, and describes accuracy 
considerations when connecting resistive transducers to the signal 
conditioning system.

RTDs
A resistive-temperature detector (RTD) is a temperature-sensing device 
whose resistance increases with temperature. An RTD consists of a wire 
coil or deposited film of pure metal. RTDs are made of different metals and 
have different resistances, but the most popular RTD is made of platinum 
and has a nominal resistance of 100 Ω at 0 °C.

RTDs are known for their excellent accuracy over a wide temperature 
range. Some RTDs have accuracies as high as 0.01 Ω (0.026 °C) at 0 °C. 
RTDs are also extremely stable devices. Common industrial RTDs drift less 
than 0.1 °C/year, and some models are stable to within 0.0025 °C/year.

RTDs are sometimes difficult to measure because they have relatively low 
nominal resistance (commonly 100 Ω) that changes only slightly with 
temperature (less than 0.4 Ω/°C). To accurately measure these small 
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changes in resistance, you must use special configurations that minimize 
measured errors caused by lead-wire resistance.

RTD Measurement Errors
Because the RTD is a resistive device, you must pass a current through the 
device and monitor the resulting voltage. However, any resistance in the 
lead wires that connect the measurement system to the RTD adds error to 
the readings. For example, consider a 2-wire RTD element connected to a 
measurement system that also supplies a constant current, IEX, to excite the 
RTD. As shown in Figure 4-2, the voltage drop across the lead resistances 
(labeled RL) adds an error voltage to the measured voltage.

Figure 4-2.  2-Wire RTD Measurement

For example, a lead resistance of 0.3 Ω in each wire adds a 0.6 Ω error to 
the resistance measurement. For a platinum RTD at 0 °C with α = 0.00385, 
the lead resistance equates to an error of approximately

Chapter 2, Connecting Signals, describes different ways of connecting 
resistive devices to the SCXI system.

The Relationship Between Resistance and 
Temperature in RTDs
Compared to other temperature-measurement devices, the output of an 
RTD is relatively linear with respect to temperature. The temperature 
coefficient, called alpha (α), differs between RTD curves. Although 
various manufacturers specify alpha differently, alpha is most commonly 
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defined as the change in RTD resistance from 0 to 100 °C, divided by the 
resistance at 0 °C, divided by 100 °C:

where

R100 is the resistance of the RTD at 100 °C.

R0 is the resistance of the RTD at 0 °C.

For example, a 100 Ω platinum RTD with α = 0.003911 has a resistance of 
139.11 Ω at 100 °C.

Figure 4-3 displays a typical resistance-temperature curve for a 100 Ω 
platinum RTD.

Figure 4-3.  Resistance-Temperature Curve for a 100 Ω Platinum RTD, α = 0.00385
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Although the resistance-temperature curve is relatively linear, accurately 
converting measured resistance to temperature requires curve fitting. The 
following Callendar-Van Dusen equation is commonly used to approximate 
the RTD curve:

where 

RT is the resistance of the RTD at temperature T.

R0 is the resistance of the RTD at 0 °C.

A, B, and C are the Callendar-Van Dusen coefficients shown in 
Table 4-1.

T is the temperature in °C.

Table 4-1 lists the RTD types and their corresponding coefficients.

Table 4-1.  Platinum RTD Types

Standard

Temperature 
Coefficient of 

Resistance 
(TCR, PPM)

Typical 
R0

Callendar-Van 
Dusen Coefficient

IEC-751
DIN 43760 
BS 1904 
ASTM-E1137 
EN-60751 

3851 100 Ω
1000 Ω

A = 3.9083 × 10–3

B = –5.775 × 10–7

C = –4.183 × 10–12

Low cost 
vendor 
compliant1

3750 1000 Ω A = 3.81 × 10–3

B = –6.02 × 10–7

C = –6.0 × 10–12

JISC 1604 3916 100 Ω A = 3.9739 × 10–3

B = –5.870 × 10–7

C = –4.4 × 10–12

US Industrial 
Standard D-100 
American

3920 100 Ω A = 3.9787 × 10–3

B = –5.8686 × 10–7

C = –4.167 × 10–12

RT R0 1 AT BT2 C T 100–( )3+ + +[ ]=
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For temperatures above 0 °C, coefficient C equals 0, reducing this equation 
to a quadratic. If you pass a known current, IEX, through the RTD and 
measure the output voltage developed across the RTD, V0 , you can solve 
for T as follows:

where

V0 is the measured RTD voltage.

IEX is the excitation current.

US Industrial 
Standard 
American

3911 100 Ω A = 3.9692 × 10–3

B = –5.8495 × 10–7

C = –4.233 × 10–12

ITS-90 3928 100 Ω A = 3.9888 × 10–3

B = –5.915 × 10–7

C = –3.85 × 10–12

1 No standard. Check TCR.

Table 4-1.  Platinum RTD Types (Continued)

Standard

Temperature 
Coefficient of 

Resistance 
(TCR, PPM)

Typical 
R0

Callendar-Van 
Dusen Coefficient

T
R0

V0
IEX
-------–

–0.5 R0A R0
2A2 4R0B R0

V0
IEX
-------–⎝ ⎠

⎛ ⎞–+
⎝ ⎠
⎜ ⎟
⎛ ⎞

------------------------------------------------------------------------------------------------=

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 4 Theory of Operation

SCXI-1503 User Manual 4-10 ni.com

Thermistors
A thermistor is a piece of semiconductor made from metal oxides, pressed 
into a small bead, disk, wafer, or other shape, sintered at high temperatures, 
and finally coated with epoxy or glass. The resulting device exhibits an 
electrical resistance that varies with temperature.

There are two types of thermistors: negative temperature coefficient (NTC) 
thermistors, whose resistance decreases with increasing temperature, and 
positive temperature coefficient (PTC) thermistors, whose resistance 
increases with increasing temperature. NTC thermistors are more 
commonly used than PTC thermistors, especially for temperature 
measurement applications.

A main advantage of thermistors for temperature measurement is their 
extremely high sensitivity. For example, a 2,252 Ω thermistor has a 
sensitivity of –100 Ω/°C at room temperature. Higher resistance 
thermistors can exhibit temperature coefficients of –10 kΩ/°C or more. 
In comparison, a 100 Ω platinum RTD has a sensitivity of only 0.4 Ω /°C.

Also, the physically small size and low thermal mass of a thermistor bead 
allows a very fast response to temperature changes.

Another advantage of the thermistor is its relatively high resistance. 
Thermistors are available with base resistances (at 25 °C) ranging from 
hundreds to millions of ohms. This high resistance diminishes the effect of 
inherent resistances in the lead wires, which can cause significant errors 
with low resistance devices such as RTDs. For example, while RTD 
measurements typically require 3- or 4-wire connections to reduce errors 
caused by lead-wire resistances, 2-wire connections to thermistors are 
usually adequate.

The major trade-off for the high resistance and sensitivity of the thermistor 
is its highly nonlinear output and relatively limited operating range. 
Depending on the type of thermistor, the upper range is typically limited to 
around 300 °C. Figure 4-4 shows the resistance-temperature curve for a 
2,252 Ω thermistor. The curve of a 100 Ω RTD is also shown for 
comparison.
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Figure 4-4.  Resistance-Temperature Curve for a 2,252 Ω Thermistor

The thermistor has been used primarily for high-resolution measurements 
over limited temperature ranges. However, continuing improvements in 
thermistor stability, accuracy, and interchangeability have prompted 
increased use of thermistors in a variety of applications.

Thermistor Measurement Circuits
This section details information about thermistor measurement circuits. 
The most common technique is to use a current-source, and measure the 
voltage developed across the thermistor. Figure shows the measured 
voltage V0 equals RT × IEX.

Figure 4-5.  Thermistor Measurement with Constant Current Excitation

,

+

–
V0

V0 = IEX x RT

RT
Thermistor

IEX
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The maximum resistance of the thermistor is determined from the current 
excitation value and the maximum voltage range of the input device. When 
using the SCXI-1503, the maximum measurable resistance is 100 kΩ.

The level of the voltage output signal depends directly on the thermistor 
resistance and magnitude of the current excitation. Do not use a higher level 
of current excitation in order to produce a higher level output signal 
because the current causes the thermistor to heat internally, leading to 
temperature-measurement errors. This phenomena is called self-heating. 
When current passes through the thermistor, power dissipated by the 
thermistor equaling (IEX

2RT), heats the thermistor.

Thermistors, with their small size and high resistance, are particularly 
prone to these self-heating errors. Manufacturers typically specify this 
self-heating as a dissipation constant, which is the power required to heat 
the thermistor 1 °C from ambient temperature (mW/°C). The dissipation 
constant depends heavily on how easily heat is transferred away from the 
thermistor, so the dissipation constant can be specified for different 
media—in still air, water, or oil bath. Typical dissipation constants range 
anywhere from less than 0.5 mW/°C for still air to 10 mW/°C or higher for 
a thermistor immersed in water. A 2,252 Ω thermistor powered by a 
100 μA excitation current dissipates:

If this thermistor has a dissipation constant of 10 mW/°C, the thermistor 
self-heats 0.00225 °C so the self-heating from the 100 μA source of the 
SCXI-1503 is negligible for most applications. It is still important to 
carefully read self-heating specifications of the thermistors.

Resistance/Temperature Characteristic of 
Thermistors
The resistance-temperature behavior of thermistors is highly dependent 
upon the manufacturing process. Therefore, thermistor curves are not 
standardized to the extent that thermocouple or RTD curves are 
standardized. Typically, thermistor manufacturers supply the 
resistance-versus-temperature curves or tables for their particular devices. 
You can, however, approximate the thermistor curve relatively accurately 
with the Steinhart-Hart equation:

I2R 100 μA2 2,252 Ω× 0.0225 mW= =

T(°K ) 1
a b ln RT( )[ ] c ln RT( )[ ]3+ +
------------------------------------------------------------------=
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where

T(°K) is the temperature in degrees Kelvin, equal to T(°C) + 273.15.

RT is the resistance of the thermistor.

a, b, and c are coefficients obtained from the thermistor manufacturer 
or calculated from the resistance-versus-temperature curve.
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5
Using the SCXI-1503

This chapter makes suggestions for developing your application and 
provides basic information regarding calibration.

Developing Your Application in NI-DAQmx

Note If you are not using an NI ADE, using an NI ADE prior to version 8.1, or are using 
an unlicensed copy of an NI ADE, additional dialog boxes from the NI License Manager 
appear allowing you to create a task or global channel in unlicensed mode. These messages 
continue to appear until you install version 8.1 or later of an NI ADE.

This section describes how to configure and use NI-DAQmx to control the 
SCXI-1503 in LabVIEW, LabWindows/CVI, and Measurement Studio. 
These ADEs provide greater flexibility and access to more settings than 
MAX, but you can use ADEs in conjunction with MAX to quickly create a 
customized application.

Typical Program Flowchart
Figure 5-1 shows a typical program voltage measurement flowchart for 
creating a task to configure channels, take a measurement, analyze the data, 
present the data, stop the measurement, and clear the task.
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Figure 5-1.  Typical Program Flowchart for Voltage Measurement Channels
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General Discussion of Typical Flowchart
The following sections briefly discuss some considerations for a few of the 
steps in Figure 5-1. These sections are meant to give an overview of some 
of the options and features available when programming with NI-DAQmx.

Creating a Task Using DAQ Assistant or 
Programmatically
When creating an application, you must first decide whether to create the 
appropriate task using the DAQ Assistant or programmatically in the ADE.

Developing your application using DAQ Assistant gives you the ability to 
configure most settings such as measurement type, selection of channels, 
excitation voltage, signal input limits, task timing, and task triggering. You 
can access the DAQ Assistant through MAX or your NI ADE. Choosing to 
use the DAQ Assistant can simplify the development of your application. 
NI recommends creating tasks using the DAQ Assistant for ease of use, 
when using a sensor that requires complex scaling, or when many 
properties differ between channels in the same task.

If you are using an ADE other than an NI ADE, or if you want to explicitly 
create and configure a task for a certain type of acquisition, you can 
programmatically create the task from your ADE using functions or VIs. 
If you create a task using the DAQ Assistant, you can still further configure 
the individual properties of the task programmatically with functions 
or property nodes in your ADE. NI recommends creating a task 
programmatically if you need explicit control of programmatically 
adjustable properties of the DAQ system.

Programmatically adjusting properties for a task created in the DAQ 
Assistant overrides the original, or default, settings only for that session. 
The changes are not saved to the task configuration. The next time you load 
the task, the task uses the settings originally configured in the DAQ 
Assistant.

Adjusting Timing and Triggering
There are several timing properties that you can configure through the 
DAQ Assistant or programmatically using function calls or property nodes. 
If you create a task in the DAQ Assistant, you can still modify the timing 
properties of the task programmatically in your application.

When programmatically adjusting timing settings, you can set the task to 
acquire continuously, acquire a buffer of samples, or acquire one point at a 
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time. For continuous acquisition, you must use a while loop around the 
acquisition components even if you configured the task for continuous 
acquisition using MAX or the DAQ Assistant. For continuous and buffered 
acquisitions, you can set the acquisition rate and the number of samples to 
read in the DAQ Assistant or programmatically in your application. By 
default, the clock settings are automatically set by an internal clock based 
on the requested sample rate. You also can select advanced features such as 
clock settings that specify an external clock source, internal routing of the 
clock source, or select the active edge of the clock signal.

Configuring Channel Properties
All ADEs used to configure the SCXI-1503 access an underlying set of 
NI-DAQmx properties. Table 5-1 shows some of these properties. You can 
use Table 5-1 to determine what kind of properties you need to set to 
configure the module for your application. For a complete list of 
NI-DAQmx properties, refer to your ADE help file.

Note You cannot adjust some properties while a task is running. For these properties, you 
must stop the task, make the adjustment, and re-start the application. Tables 5-1 
through 5-3 assume all properties are configured before the task is started.

Table 5-1.  NI-DAQmx Voltage Measurement Properties

Property Short Name Description

DAQ 
Assistant 

Accessible

Analog Input»Maximum 
Value

AI.Max Specifies the maximum value 
you expect to measure. The 
SCXI-1503 gain and E/M 
Series DAQ device range are 
computed automatically from 
this value.

Yes

Analog Input»Minimum 
Value

AI.Min Specifies the minimum value 
you expect to measure. The 
SCXI-1503 gain and E/M 
Series DAQ device range are 
computed automatically from 
this value.

Yes
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Analog Input»General 
Properties»Advanced»
Gain and Offset»Gain 
Value

AI.Gain Specifies a gain factor to apply 
to the signal conditioning 
portion of the channel. The 
SCXI-1503 supports 1 or 100.

No

Analog Input»General 
Properties»Advanced»
High Accuracy Settings»
Auto Zero Mode

AI.AutoZeroMode Specifies when to measure 
ground. NI-DAQmx subtracts 
the measured ground voltage 
from every sample. The 
SCXI-1503 supports None or 
Once.

Yes

Analog Input»General 
Properties»Advanced»
Input Configuration»
Coupling

AI.Coupling Specifies the input coupling of 
the channel. The SCXI-1503 
supports DC and GND 
coupling.

No

Table 5-2.  NI-DAQmx RTD Measurement Properties

Property Short Name Description

DAQ 
Assistant 

Accessible

Analog Input»Temperature» 
RTD»Type

AI.RTD.Type Specifies the type of 
RTD connected to the 
channel.

Yes

Analog Input»Temperature» 
RTD»R0

AI.RTD.R0 Specifies the 
resistance in ohms of 
the sensor at 0 °C.

Yes

Table 5-1.  NI-DAQmx Voltage Measurement Properties (Continued)

Property Short Name Description

DAQ 
Assistant 

Accessible
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Analog Input»Temperature» 
RTD»Custom»A, B, C

AI.RTD.A
AI.RTD.B
AI.RTD.C

Specifies the A, B, or 
C constant of the 
Callendar-Van Dusen 
equation when using a 
custom RTD type.

Yes

Analog Input»General 
Properties»Signal 
Conditioning»Resistance 
Configuration

AI.Resistance.Cfg Specifies the 
resistance 
configuration for the 
channel, such as 
2-wire, 3-wire, or 
4-wire.

Yes

Table 5-3.  NI-DAQmx Thermistor Measurement Properties

Property Short Name Description

DAQ 
Assistant 
Accessible

Analog Input»Temperature» 
Thermistor»R1

AI.Thrmistr.R1 Specifies the resistance in 
ohms of the sensor at 0 °C.

Yes

Analog Input»Temperature» 
Thermistor»Custom»A, B, C

AI.Thrmistr.A
AI.Thrmistr.B
AI.Thrmistr.C

Specifies the A, B, or C 
constant of the Steinhart-Hart 
thermistor equation, which 
NI-DAQmx uses to scale 
thermistors.

Yes

Table 5-2.  NI-DAQmx RTD Measurement Properties (Continued)

Property Short Name Description

DAQ 
Assistant 

Accessible
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Note This is not a complete list of NI-DAQmx properties and does not include every 
property you may need to configure your application. It is a representative sample of 
important properties to configure for voltage measurements. For a complete list of 
NI-DAQmx properties and more information about NI-DAQmx properties, refer to your 
ADE help file.

Acquiring, Analyzing, and Presenting
After configuring the task and channels, you can start the acquisition, read 
measurements, analyze the data returned, and display it according to the 
needs of your application. Typical methods of analysis include digital 
filtering, averaging data, performing harmonic analysis, applying a custom 
scale, or adjusting measurements mathematically.

NI provides powerful analysis toolsets for each NI ADE to help you 
perform advanced analysis on the data without requiring you to have a 
programming background. After you acquire the data and perform any 
required analysis, it is useful to display the data in a graphical form or log 
it to a file. NI ADEs provide easy-to-use tools for graphical display, such as 

Table 5-4.  NI-DAQmx Thermocouple Measurement Properties

Property Short Name Description

DAQ 
Assistant 

Accessible

Analog Input»Temperature» 
Thermocouple»Type

AI.Thermcpl.Type Specifies the type of 
thermocouple 
connected to the 
channel.

Yes

Analog Input»Temperature» 
Thermocouple»CJC Source

AI.Thermcpl.CJCSrc Indicates the source of 
cold-junction 
compensation.

Yes

Analog Input»Temperature» 
Thermocouple»CJC Value

AI.Thermcpl.CJCVal Specifies the 
temperature of the 
cold-junction if the 
CJC source is constant 
value.

Yes

Analog Input»Temperature» 
Thermocouple»CJC Channel

AI.Thermcpl.CJCChan Indicates the channel 
that acquires the 
temperature of the 
cold junction if CJC is 
channel.

Yes
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charts, graphs, slide controls, and gauge indicators. NI ADEs have tools 
that allow you to easily save the data to files such as spread sheets for easy 
viewing, ASCII files for universality, or binary files for smaller file sizes.

Completing the Application
After you have completed the measurement, analysis, and presentation of 
the data, it is important to stop and clear the task. This releases any memory 
used by the task and frees up the DAQ hardware for use in another task.

Note In LabVIEW, tasks are automatically cleared.

Developing an Application Using LabVIEW
This section describes in more detail the steps shown in the typical program 
flowchart in Figure 5-1, such as how to create a task in LabVIEW and 
configure the channels of the SCXI-1503. If you need more information or 
for further instructions, select Help»VI, Function, & How-To Help from 
the LabVIEW menu bar.

Note Except where otherwise stated, the VIs in Table 5-5 are located on the Functions» 
All Functions»NI Measurements»DAQmx - Data Acquisition subpalette and 
accompanying subpalettes in LabVIEW.

Table 5-5.  Programming a Task in LabVIEW

Flowchart Step VI or Program Step

Create Task in DAQ Assistant Create a DAQmx Task Name Control located on the 
Controls»All Controls»I/O»DAQmx Name Controls 
subpalette, right-click it, and select New Task (DAQ 
Assistant).

Create a Task 
Programmatically 
(optional)

DAQmx Create Task.vi located on the Functions»All 
Functions»NI Measurements»DAQmx - Data Acquisition»
DAQmx Advanced Task Options subpalette—This VI is 
optional if you created and configured the task using the DAQ 
Assistant. However, if you use it in LabVIEW, any changes you 
make to the task are not saved to a task in MAX.
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Create Virtual Channel(s) DAQMX Create Virtual Channel.vi located on the 
Functions»All Functions»NI Measurements»DAQmx - Data 
Acquisition subpalette—Use this VI to add virtual channels to 
the task. Select the type of virtual channel based on the 
measurement you plan to perform.

Adjust Timing Settings 
(optional)

DAQmx Timing.vi (Sample Clock by default)—This VI is 
optional if you created and configured the task using the DAQ 
Assistant. Any timing settings modified with this VI are not 
saved in the DAQ Assistant. They are only available for the 
present session.

Configure Channels 
(optional)

NI-DAQmx Channel Property Node, refer to the Using a 
NI-DAQmx Channel Property Node in LabVIEW section for 
more information. This step is optional if you created and fully 
configured the channels using the DAQ Assistant. Any channel 
modifications made with a channel property node are not saved 
in the task in the DAQ Assistant. They are only available for the 
present session.

Start Measurement DAQmx Start Task.vi

Read Measurement DAQmx Read.vi

Analyze Data Some examples of data analysis include filtering, scaling, 
harmonic analysis, or level checking. Some data analysis tools 
are located on the Functions»Signal Analysis subpalette and on 
the Functions»All Functions»Analyze subpalette.

Display Data You can use graphical tools such as charts, gauges, and graphs 
to display the data. Some display tools are located on the 
Controls»All Controls»Numeric»Numeric Indicator 
subpalette and Controls»All Controls»Graph subpalette.

Continue Sampling For continuous sampling, use a While Loop. If you are using 
hardware timing, you also need to set the DAQmx Timing.vi 
sample mode to Continuous Samples. To do this, right-click the 
terminal of the DAQmx Timing.vi labeled sample mode and 
click Create»Constant. Click the box that appears and select 
Continuous Samples.

Table 5-5.  Programming a Task in LabVIEW (Continued)

Flowchart Step VI or Program Step
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Using a NI-DAQmx Channel Property Node in 
LabVIEW
You can use property nodes in LabVIEW to manually configure the 
channels. To create a LabVIEW property node, complete the following 
steps:

1. Launch LabVIEW.

2. Create the property node in a new VI or in an existing VI.

3. Open the block diagram view.

4. From the Functions toolbox, select All Functions»NI 
Measurements»DAQmx - Data Acquisition, and select DAQmx 
Channel Property Node.

5. The ActiveChans property is displayed by default. This allows you to 
specify exactly what channel(s) you want to configure. If you want to 
configure several channels with different properties, separate the lists 
of properties with another Active Channels box and assign the 
appropriate channel to each list of properties.

Note If you do not use Active Channels, the properties are set on all of the channels in 
the task.

6. Right-click ActiveChans, and select Add Element. Left-click the new 
ActiveChans box. Navigate through the menus, and select the 
property you wish to define.

7. Change the property to read or write to either get the property or write 
a new value. Right-click the property, go to Change To, and select 
Write, Read, or Default Value.

8. After you have added the property to the property node, right-click the 
terminal to change the attributes of the property, add a control, 
constant, or indicator.

9. To add another property to the property node, right-click an existing 
property and left-click Add Element. To change the new property, 
left-click it and select the property you wish to define.

Stop Measurement DAQmx Stop Task.vi (This VI is optional, clearing the task 
automatically stops the task.)

Clear Task DAQmx Clear Task.vi

Table 5-5.  Programming a Task in LabVIEW (Continued)

Flowchart Step VI or Program Step

Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 5 Using the SCXI-1503

© National Instruments Corporation 5-11 SCXI-1503 User Manual

Note Refer to the LabVIEW Help for information about property nodes and specific 
NI-DAQmx properties.

Specifying Channel Strings in NI-DAQmx
Use the channel input of DAQmx Create Channel to specify the 
SCXI-1503 channels. The input control/constant has a pull-down menu 
showing all available external channels. The strings take one of the 
following forms:

• single device identifier/channel number—for example SC1Mod1/ai0

• multiple, noncontinuous channels—for example SC1Mod1/ai0, 
SC1Mod1/ai4.

• multiple continuous channels—for example SC1Mod1/ai0:4 
(channels 0 through 4)

When you have a task containing SCXI-1503 channels, you can set the 
properties of the channels programmatically using the DAQmx Channel 
Property Node.

Text Based ADEs
You can use text based ADEs such as LabWindows/CVI, Measurement 
Studio, Visual Basic 6, .NET, and C# to create code for using the 
SCXI-1503.

LabWindows/CVI
LabWindows/CVI works with the DAQ Assistant in MAX to generate 
code for an voltage measurement task. You can then use the appropriate 
function call to modify the task. To create a configurable channel or task in 
LabWindows/CVI, complete the following steps:

1. Launch LabWindows/CVI.

2. Open a new or existing project.

3. From the menu bar, select Tools»Create/Edit DAQmx Tasks.

4. Choose Create New Task In MAX or Create New Task In Project 
to load the DAQ Assistant.

5. The DAQ Assistant creates the code for the task based on the 
parameters you define in MAX and the device defaults. To change 
a property of the channel programmatically, use the 
DAQmxSetChanAttribute function.
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Note Refer to the NI LabWindows/CVI Help for more information on creating NI-DAQmx 
tasks in LabWindows/CVI and NI-DAQmx property information.

Measurement Studio (Visual Basic 6, .NET, and C#)
When creating an voltage measurement task in Visual Basic 6, .NET and 
C#, follow the general programming flow in Figure 5-1. You can then use 
the appropriate function calls to modify the task. This example creates a 
new task and configures an NI-DAQmx voltage measurement channel on 
the SCXI-1503. You can use the same functions for Visual Basic 6, .NET 
and C#.

The following text is a function prototype example:

void AIChannelCollection.CreateVoltageChannel(

System.String physicalChannelName,

System.String nameToAssignChannel,

System.Double minVal,

System.Double maxVal);

To actually create and configure the channel, you would enter something 
resembling the following example code:

Task myTask = new 

NationalInstruments.DAQmx.Task(“myTaskName”);

MyTask.DAQmxCreateAIVoltageChan (

“SC1Mod1/ai0”, // System.String physicalChannelName

“Voltage0”, // System.String nameToAssignChannel

-10.0, // System.Double minVal

10.0); // System.Double maxVal

// setting attributes after the channel is created

AIChannel myChannel = myTask.AIChannels[“Voltage0”];

myChannel.AutoZeroMode = kAutoZeroTypeOnce;

Modify the example code above or the code from one of the shipping 
examples as needed to suit your application.

Note You can create and configure the voltage measurement task in MAX and 
load it into your application with the function call 
NationalInstruments.DAQmx.DaqSystem.Local.LoadTask.

Refer to the NI Measurement Studio Help for more information on creating NI-DAQmx 
tasks in LabWindows/CVI and NI-DAQmx property information.
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Programmable NI-DAQmx Properties
All of the different ADEs that configure the SCXI-1503 access an 
underlying set of NI-DAQmx properties. Tables 5-1 through 5-4 provide a 
list of some of the properties that configure the SCXI-1503. You can use 
this list to determine what kind of properties you need to set to configure 
the device for your application. For a complete list of NI-DAQmx 
properties, refer to your ADE help file.

Note Tables 5-1 through 5-4 are not complete lists of NI-DAQmx properties and do not 
include every property you may need to configure voltage measurements. It is a 
representative sample of important properties to configure voltage measurements. For a 
complete list of NI-DAQmx properties and more information on NI-DAQmx properties, 
refer to your ADE help file.

Calibration
The SCXI-1503 is shipped with a calibration certificate and is calibrated at 
the factory to the specifications described in Appendix A, Specifications. 
Calibration constants are stored inside the calibration EEPROM and 
provide software correction values your application development software 
uses to correct the measurements for both offset and gain errors in the 
module.

Internal/Self-Calibration
You can self-calibrate the SCXI-1503 in MAX by right-clicking the 
module and selecting Self Calibrate. The NI-DAQmx Self Calibrate Device 
function does the same. A self-calibration of the SCXI-1503 grounds all the 
input channels and stores the resulting measurement as an offset correction 
constant on the module. You should perform a self-calibration every time 
you install the SCXI-1503 to a new system.

Note You should self-calibrate the connected DAQ device before self-calibrating the 
SCXI-1503.

External Calibration
If you have an accurate calibrator and DMM, you can externally calibrate 
the SCXI-1503 gain and offset constants using NI-DAQmx functions. You 
can also calibrate the 100 μA current excitation.
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The functions that are required for externally calibrating the SCXI-1503 are 
available in NI-DAQmx 8.1 or later. Refer to the NI-DAQmx Help for 
details about these functions.

Most external calibration documents for SCXI modules are available to 
download from ni.com/calibration by clicking Manual Calibration 
Procedures. For external calibration of modules not listed there, Basic 
Calibration Service or Detailed Calibration Service is recommended. You 
can get information about both of these calibration services from 
ni.com/calibration. NI recommends performing an external 
calibration once a year.

Note Performing an external calibration of the SCXI-1503 permanently overwrites the 
factory calibration settings, which impacts the accuracy of the inputs.
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A
Specifications

This appendix lists the specifications for the SCXI-1503 modules. 
These specifications are typical at 25 °C unless otherwise noted.

Analog Input

Input Characteristics
Number of channels ............................... 16 differential

Input coupling ........................................ DC

Input signal ranges ................................. ±100 mV (gain = 100) or 
±10 V (gain = 1)

Input overvoltage protection

Powered on ..................................... ±42 VDC

Powered off..................................... ±25 V

Inputs protected............................... AI<0..15>

CJ sensor input protection............... ±15 VDC powered on or off

Transfer Characteristics
Nonlinearity ........................................... 0.005% FSR

Input offset error (RTI)

Gain = 1

Calibrated 1 .............................. ±650 μV max
±250 μV typ

With autozero enabled 2 ........... ±300 μV max
±150 μV typ

1   Assumes 1,000 point average, 25 °C ±10 °C over one year.
2   Assumes 1,000 point average, ±1 °C of autozero temperature.
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Gain = 100

Calibrated1................................±25 μV max
±10 μV typ

With autozero enabled2 ............±10 μV max
±5 μV typ

Gain error (relative to calibration reference)

Gain = 1 or 100

Calibrated1................................0.074% of reading max
0.02% of reading typ

RTD Measurement Accuracy

Amplifier Characteristics
Input coupling.........................................DC

Input impedance

Normal powered on .........................>1 GΩ

Input bias current ....................................±2.8 nA

1   Assumes 1,000 point average, 25 °C ±10 °C over one year.
2   Assumes 1,000 point average, ±1 °C of autozero temperature.

Table A-1.  RTD Measurement Accuracy

Measured 
Temperature °C 100 Ω Max °C 100 Ω Typ °C 1000 Ω Max °C 1000 Ω Typ °C

–100 to 0 0.60 0.23 1.09 0.46

0 to 25 0.62 0.23 1.11 0.47

25 to 100 0.69 0.25 1.20 0.49

100 to 500 1.11 0.37 1.68 0.65

500 to 1200 2.06 0.65 2.81 1.04

Notes: The accuracies in this table reflect using the module in4-wire mode. They do not include errors from the RTD 
including lead-wire errors when using 2- or 3-wire connection.

The accuracies assume auto-zero is enabled and the environmental conditions are 25 °C ±10 °C over a one year period.

These accuracies were computed using a standard RTD with a TCR of 3851.

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix A Specifications

© National Instruments Corporation A-3 SCXI-1503 User Manual

CMRR characteristics (DC to 60 Hz)

Gain 1.............................................. –75 dB min
–90 dB typ

Gain 100.......................................... –106 dB min
–110 dB typ

Output range........................................... ±10 V

Output impedance .................................. 91 Ω

Dynamic Characteristics
Minimum scan interval (per channel, any gain)

±0.012% accuracy........................... 3 μs

±0.0061% accuracy......................... 10 μs

±0.0015% accuracy......................... 20 μs

Noise characteristics (RTI)

Gain = 1
10 Hz to 1 MHz .............................. 100 μVrms

Gain = 100
10 Hz to 1 MHz .............................. 1 μVrms

0.1 to 10 Hz..................................... 0.5 μVp-p

Filter
Cutoff frequency (–3 dB)....................... 5 Hz

NMR (60 Hz) ......................................... –40 dB min

Step response characteristics (gain 1 or 100)

To 0.0015%..................................... 0.6 s

Stability
Recommended warm-up time ................ 20 min

Offset temperature coefficient

Gain = 1 .......................................... ±35 μV/°C max
±10 μV/°C typ

Gain = 100 ...................................... ±1.5 μV/°C max
±0.5 μV/°C typ

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix A Specifications

SCXI-1503 User Manual A-4 ni.com

Gain temperature coefficient
(gain 1 or 100) ........................................±15 ppm/°C max

±5 ppm/°C typ

Excitation
Channels .................................................16 single-ended outputs

Current output.........................................100 μA

Accuracy .................................................±0.05%

Temperature drift ....................................±5 ppm/°C

Output voltage compliance .....................10 V

Maximum resistive load .........................100 kΩ

Overvoltage protection ...........................±40 VDC

Measurement Category...........................CAT I

Power Requirements From SCXI Backplane
V+ ...........................................................18.5 to 25 VDC, 170 mA

V– ...........................................................–18.5 to –25 VDC, –170 mA

+5 V ........................................................+4.75 to 5.25 VDC, 50 mA

Environmental
Operating temperature ............................0 to 50 °C

Storage temperature ................................–20 to 70 °C

Humidity .................................................10 to 90% RH, noncondensing

Maximum altitude...................................2,000 meters

Pollution Degree (indoor use only) ........2
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Physical

Figure A-1.  SCXI-1503 Dimensions

Weight .................................................... 745 g (26.3 oz)

Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the 
common-mode voltage.

Signal + common mode ......................... Each input should remain 
within ±10 V of AI GND

18.8 cm 
(7.4 in.)

17.2 cm
(6.8 in.)

3.0 cm
(1.2 in.)
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Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN-61010-1

• UL 61010-1, CSA 61010-1

Note For UL and other safety certifications, refer to the product label or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Electromagnetic Compatibility
This product is designed to meet the requirements of the following 
standards of EMC for electrical equipment for measurement, control, 
and laboratory use:

• EN 61326 EMC requirements; Minimum Immunity

• EN 55011 Emissions; Group 1, Class A

• CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device according to product documentation.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

• 73/23/EEC; Low-Voltage Directive (safety)

• 89/336/EEC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 
center. For more information about WEEE recycling centers and National Instruments 
WEEE initiatives, visit ni.com/environment/weee.htm.
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B
Removing the SCXI-1503

This appendix explains how to remove the SCXI-1503 from MAX and an 
SCXI chassis or PXI/SCXI combination chassis.

Removing the SCXI-1503 from MAX
To remove a module from MAX, complete the following steps after 
launching MAX:

1. Expand Devices and Interfaces.

2. Click the + next to NI-DAQmx to expand the list of installed chassis.

3. Click the + next to the appropriate chassis to expand the list of installed 
modules.

4. Right-click the module or chassis you want to delete and click Delete.

5. A confirmation window opens. Click Yes to continue deleting the 
module or chassis or No to cancel this action.

Note Deleting the SCXI chassis deletes all modules in the chassis. All configuration 
information for these modules is also lost.

The SCXI chassis and/or SCXI module(s) should now be removed from the 
list of installed devices in MAX.

Removing the SCXI-1503 from a Chassis
Consult the documentation for the chassis and accessories for additional 
instructions and precautions. To remove the SCXI-1503 module from a 
chassis, complete the following steps while referring to Figure B-1:

1. Power off the chassis. Do not remove the SCXI-1503 module from a 
chassis that is powered on.

2. If the SCXI-1503 is the module cabled to the E/M Series DAQ device, 
disconnect the cable.

3. Remove any terminal block that connects to the SCXI-1503.
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4. Rotate the thumbscrews that secure the SCXI-1503 to the chassis 
counterclockwise until they are loose, but do not completely remove 
the thumbscrews.

Remove the SCXI-1503 by pulling steadily on both thumbscrews until the 
module slides completely out.

Figure B-1.  Removing the SCXI-1503

1 Cable
2 SCXI Module Thumbscrews

3 SCXI-1503
4 Terminal Block

5 SCXI Chassis Power Switch
6 SCXI Chassis
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Common Questions

This appendix lists common questions related to the use of the SCXI-1503.

Which version of NI-DAQ works with the SCXI-1503, and how do I get 
the most current version of NI-DAQ?

You must have NI-DAQ 8.1 or later. Visit the NI Web site at ni.com and 
select Download Software»Drivers and Updates»Search Drivers and 
Updates. Enter the keyword NI-DAQ to find the latest version of NI-DAQ 
for your operating system.

I cannot correctly test and verify that my SCXI-1503 is working. What 
should I do?

Unfortunately, there is always the chance that one or more components in 
the system are not operating correctly. You may have to call or email a 
technical support representative. The technical support representative often 
suggests troubleshooting measures. If requesting technical support by 
phone, have the system nearby so you can try these measures immediately. 
NI contact information is listed in the Technical Support Information 
document.

Can the SCXI-1503 current outputs be interactively controlled in 
MAX or programmatically controlled using NI-DAQ function calls, 
LabVIEW, or Measurement Studio?

No. The current-output level is 100 μA as long as the chassis is powered on. 
You cannot power off or adjust the current output using MAX, NI-DAQ 
function calls, or an ADE such as LabVIEW or Measurement Studio. If you 
require this functionality, consider using an SCXI-1124 module or NI 670X 
device instead.

How can I ground a floating voltage measurement?

You can use the IEX– terminal of each channel as a ground reference. Refer 
to the SCXI-1306 Terminal Block Installation Guide for details about using 
the SCXI-1306 DIP switches to control ground referencing.

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix C Common Questions

SCXI-1503 User Manual C-2 ni.com

Can I connect N current-output channels in parallel to create a 
precision current source that provides N × 100 μA?

Yes, you can connect the current output in parallel. When connecting the 
output in parallel, connect the appropriate IEX+ terminals together and the 
corresponding IEX– terminals together.

Can I connect N current-output channels in series to achieve a higher 
terminal-voltage compliance limit?

No. Each current source is ground referenced. Therefore, you cannot place 
multiple current-outputs in series.

Are the SCXI-1503 channels isolated with respect to each other, the 
E/M Series DAQ device, or ground?

No. The SCXI-1503 does not contain any isolation circuitry. If you require 
isolation, consider the SCXI-1124 or SCXI-1125 module instead.

Can I modify the SCXI-1503 circuitry to generate current at a level 
different than 100 μA?

No. Do not attempt to modify any circuitry in the SCXI-1503.

Are there any user-serviceable parts inside the SCXI-1503?

No. There are no fuses, potentiometers, switches, socketed resistors, or 
jumpers inside the module. Disassembly of the module for any reason can 
void its warranty and nullify its accuracy specification.

Can I access the unused analog-input channels of the E/M Series DAQ 
device if it is directly cabled to the SCXI-1503 in a single-chassis 
system?

Yes. E/M Series DAQ device channels 1 through 7 are available to measure 
unconditioned signals. Use an SCXI-1180 or the 50-pin breakout connector 
on the SCXI-1346 or SCXI-1349 cable adapter to route signals to these 
channels.

Which digital lines are unavailable on the E/M Series DAQ device if I 
am cabled to an SCXI-1503 module?

Table 2-4 shows the digital lines that are used by the SCXI-1503 for 
communication and scanning. These lines are unavailable for 
general-purpose digital I/O if the SCXI-1503 is connected to the 
E/M Series DAQ device.
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Does short-circuiting a current-output channel do any damage to the 
SCXI-1503?

No. The SCXI-1503 delivers 100 μA into any load from 0 Ω to 100 kΩ.

Does open-circuiting a current-output channel damage the 
SCXI-1503? What is the open-circuit voltage level?

No. An SCXI-1503 current-output channel is not damaged if no load is 
connected. The open-circuit voltage is 12.4 VDC.
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Glossary

Symbol Prefix Value

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

Numbers/Symbols

% percent

+ positive of, or plus

– negative of, or minus

± plus or minus

< less than

/ per

° degree

Ω ohms

+5 V (signal) +5 VDC source signal

A

A amperes

ADE application development environment such as LabVIEW, 
LabWindows/CVI, Visual Basic, C, and C++

AI analog input

AI GND analog input ground signal
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B

bit one binary digit, either 0 or 1

C

CE European emissions control standard

C GND chassis ground signal

channel pin or wire lead to which you apply, or from which you read, an analog or 
digital signal. Analog signals can be single-ended or differential. For digital 
signals, channels (also known as lines) are grouped to form ports.

chassis the enclosure that houses, powers, and controls SCXI modules

CLK clock input signal

common-mode voltage voltage that appears on both inputs of a differential amplifier

current excitation a source that supplies the current needed by a sensor for its proper operation

D

D/A digital-to-analog

D*/A Data/Address

DAQ data acquisition—(1) collecting and measuring electrical signals from 
sensors, transducers, and test probes or fixtures and processing the 
measurement data using a computer; (2) collecting and measuring the same 
kinds of electrical signals with A/D and/or DIO devices plugged into a 
computer, and possibly generating control signals with D/A and/or DIO 
devices in the same computer

DAQ device a data acquisition device. Examples are E/M Series data acquisition devices

DAQ D*/A the data acquisition device data/address line signal used to indicate whether 
the SER DAT IN pulse train transmitted to the SCXI chassis contains data 
or address information

device a plug-in data acquisition device, module, card, or pad that can contain 
multiple channels and conversion devices. SCXI modules are distinct from 
devices, with the exception of the SCXI-1200, which is a hybrid.
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D GND digital ground signal

differential amplifier an amplifier with two input terminals, neither of which are tied to a ground 
reference, whose voltage difference is amplified

DIN Deutsche Industrie Norme (German Industrial Standard)

DIO digital input/output

DoC Declaration of Conformity

drivers/driver
software

software that controls a specific hardware device such as an E/M Series 
DAQ device 

E

EMC electromagnetic compliance

EMI electromagnetic interference

excitation a voltage or current source used to energize a sensor or circuit

EXT CLK external clock signal

G

gain the factor by which a signal is amplified, sometimes expressed in decibels

I

ID identifier

IEX+ positive excitation channel

IEX– negative excitation channel

in. inch or inches

input impedance the measured resistance and capacitance between the input terminals of a 
circuit
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J

jumper a small rectangular device used to connect two adjacent posts on a circuit 
board. Jumpers are used on some SCXI modules and terminal blocks to 
either select certain parameters or enable/disable circuit functionality.

L

lead resistance the small resistance of a lead wire. The resistance varies with the lead 
length and ambient temperature. If the lead wire carries excitation current, 
this varying resistance can cause measurement error.

M

m meters

M (1) Mega, the standard metric prefix for 1 million or 106, when used with 
units of measure such as volts and hertz; (2) mega, the prefix for 1,048,576, 
or 220, when used with B to quantify data or computer memory

MISO master-in-slave-out signal

MOSI master-out-slave-in signal

multiplex to route one of many input signals to a single output

multiplexed mode an SCXI operating mode in which analog input channels are multiplexed 
into one module output so that the cabled E/M Series DAQ device has 
access to the multiplexed output of the module as well as the outputs of all 
other multiplexed modules in the chassis

N

NC not connected (signal)

NI-DAQ the driver software needed in order to use National Instruments E/M Series 
DAQ devices and SCXI components

NI-DAQmx The latest NI-DAQ driver with new VIs, functions, and development tools 
for controlling measurement devices.

Download from Www.Somanuals.com. All Manuals Search And Download.



Glossary

© National Instruments Corporation G-5 SCXI-1503 User Manual

O

output voltage 
compliance

the largest voltage that can be generated across the output of a current 
source without the current going out of specification

OUT REF output reference signal

P

ppm parts per million

PXI PCI eXtensions for Instrumentation—an open specification that builds on 
the CompactPCI specification by adding instrumentation-specific features

R

RL lead resistance

RMA Return Material Authorization

RSVD reserved bit, pin, or signal

RTD resistance-temperature detector

S

s seconds

S samples

scan one or more analog samples taken at the same time, or nearly the same time. 
Typically, the number of input samples in a scan is equal to the number of 
channels in the input group. For example, one scan, acquires one new 
sample from every analog input channel in the group.

SCAN CLK scan clock signal used to increment to the next channel after each 
E/M Series DAQ device analog-to-digital conversion

SCXI Signal Conditioning eXtensions for Instrumentation

SCXIbus located in the rear of an SCXI chassis, the SCXIbus is the backplane that 
connects modules in the same chassis to each other
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sensor a type of transducer that converts a physical phenomenon into an electrical 
signal

SER CLK serial clock signal used to synchronize digital data transfers over the 
SER DAT IN and SER DAT OUT lines

SER DAT IN serial data input signal

SER DAT OUT serial data output signal

signal conditioning the manipulation of signals to prepare them for digitizing

Slot 0 refers to the power supply and control circuitry in the SCXI chassis

SLOT 0 SEL slot 0 select signal

SPI CLK serial peripheral interface clock signal

T

thermistor a thermally sensitive resistor

Traditional NI-DAQ 
(Legacy)

An upgrade to the earlier version of NI-DAQ. Traditional NI-DAQ 
(Legacy) has the same VIs and functions and works the same way as 
NI-DAQ 6.9.x. You can use both Traditional NI-DAQ (Legacy) and 
NI-DAQmx on the same computer, which is not possible with NI-DAQ 
6.9.x.

transducer a device capable of converting energy from one form to another

U

UL Underwriters Laboratory

V

V volts

VAC volts, alternating current

VDC volts, direct current
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VI virtual instrument—(1) a combination of hardware and/or software 
elements, typically used with a PC, that has the functionality of a classic 
stand-alone instrument; (2) a LabVIEW software module (VI), which 
consists of a front panel user interface and a block diagram program

virtual channels channel names that can be defined outside the application and used without 
having to perform scaling operations

W

W watts
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Index

Numerics
2-wire configuration of resistive devices, 2-4
3-wire resistive sensor

connected in 2-wire configuration, 2-5
lead-resistance compensation

with two matched current sources, 2-6
4-wire configuration of resistive devices, 2-3

A
adjusting timing and triggering, 5-3
AI 0 signal, multiplexing, 2-11
amplifier characteristics specifications, A-2
analog circuitry

analog input channels, 4-3
CJ SENSOR, 4-3

analog input channels, 4-3
analog input signal connections, 2-1

ground-referencing of signals, 2-2
analog input signals, multiplexed, 4-4
analog input specifications, A-1

amplifier characteristics, A-2
dynamic characteristics, A-3
input characteristics, A-1
transfer characteristics, A-1

applications
developing in NI-DAQmx, 5-1

acquiring, analyzing, and 
presenting, 5-7

completing, 5-8
LabVIEW, 5-8
program flowchart (figure), 5-2
programmable properties, 5-13
specifying channel strings, 5-11

C
cables, custom, 2-1
calibration, SCXI-1503, 5-13
CE compliance specifications, A-6
channel properties, configuring, 5-4
channels, voltage measurement flowchart 

(figure), 5-2
circuitry

analog, 4-3
digital control, 4-3

CJC source/value, 3-2
common questions, C-1
common software-configurable settings

CJC source/value, 3-2
gain/input range, 3-1

configuration, 3-1
channel properties, 5-4
SCXI-1503

common software settings, 3-1
settings in MAX

NI-DAQmx, 3-3
creating a global channel or 

task, 3-3
verifying signal, 3-4

NI-DAQmx, 3-4
configuration and testing, 3-1
configuration settings, gain/input range, 3-1
configuring channel properties, 5-4
connecting resistive devices to SCXI-1503, 2-2

2-wire configuration, 2-4
3-wire resistive sensor connected in 2-wire 

configuration, 2-5
4-wire configuration, 2-3
lead-resistance compensation

using 3-wire resistive sensor
and two matched current 

sources, 2-6
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conventions used in the manual, iv
creating a task

DAQ Assistant, 5-3
programmatically, 5-3

current output channels, questions 
about, C-1, C-3

current sources, operating, 4-4
custom cables, 2-1

D
DAQ Assistant, creating a task, 5-3
DAQ device

accessing unused analog input 
channels, C-2

DAQ devices
unavailable digital lines, C-2

digital control circuitry, 4-3
dynamic characteristics specifications, A-3

E
E/M Series DAQ devices, 4-4
electromagnetic compatibility 

specifications, A-6
environment specifications, A-4
excitation specifications, A-4

F
filters specifications, A-3
front connector

pin assignments (table), 2-8

G
gain/input range, configuration, 3-1

I
input characteristics specifications, A-1
installation into SCXI chassis, 1-4

L
LabVIEW

developing an application, 5-8
programming a task (table), 5-8
using a NI-DAQmx channel property 

node, 5-10
LabWindows/CVI

creating code for using SCXI-1503, 5-11

M
maximum working voltage specifications, A-5
Measurement & Automation Explorer

configurable settings, 3-2
removing the SCXI-1503, B-1

measurement properties, NI-DAQmx
RTD (table), 5-5
thermistor (table), 5-6
thermocouple (table), 5-7
voltage (table), 5-4

Measurement Studio
creating code for using SCXI-1503, 5-12

multiplexed mode operation
theory, 4-4

multiplexing
analog input signals, 4-4
SCXI-1503, 4-4
with AI 0 signal, 2-11

N
NI-DAQ version required, C-1
NI-DAQmx

configurable settings, 3-3
developing applications, 5-1

acquiring, analyzing, and 
presenting, 5-7

adjusting timing and triggering, 5-3
completing, 5-8
configuring channel properties, 5-4
LabVIEW, 5-8
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NI-DAQmx channel property 
node, 5-10

program flowchart (figure), 5-2
programmable properties, 5-13
specifying channel strings, 5-11

RTD measurement properties (table), 5-5
thermistor measurement properties 

(table), 5-6
thermocouple measurement properties 

(table), 5-7
voltage measurement properties 

(table), 5-4

O
operation of current sources, 4-4

P
physical specifications, A-5
pin assignments

front connector (table), 2-8
power requirements from SCXI 

backplane, A-4

Q
questions and answers, C-1

R
rear signal connector, 4-3

descriptions, 2-11
removing the SCXI-1503

from Measurement & Automation 
Explorer, B-1

resistive devices, connecting to SCXI-1503
2-wire configuration, 2-4
3-wire resistive sensor connected to 

2-wire configuration, 2-5
4-wire configuration, 2-3

lead-resistance compensation
using 3-wire resistive sensor and 

two matched current sources, 2-6
RTD

measurement properties (table), 5-5
RTDs (resistive-temperature detectors)

measurement errors, 4-6
overview, 4-5
relationship between resistance and 

temperature, 4-6
resistance-temperature curve (figure), 4-7

S
safety specifications, A-6
SCXI-1503

calibration, 5-13
common questions, C-1
common software settings, 3-1
communication signals (table), 2-11
configuration settings, 3-1
major components, 4-3
measurements, 3-3
multiplexing, 4-4
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